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GETTING STARTED 

INTRODUCING PERSONAL PORTFOLIO MANAGER 

Welcome to OWL Software’s Personal Portfolio Manager (PPM).  PPM is a fully integrated system that combines 

portfolio management with technical analysis to provide individual investors with a tool to help organize and 

analyze the information that is critical to making informed investment decisions. 

The PPM program provides complete tracking of security and cash transactions with automatic computation of net 

worth, capital gains, unrealized gains, return on investment, asset allocation and much more.  PPM also allows you 

to organize your information into up to 999 portfolios and produce reports for a single portfolio or any 

combination of portfolios.  This allows you to set up portfolios to record investments held in your name, by other 

family members, by members of an investment club or by investment clients.  As well, you could set up separate 

portfolios for retirement savings, children’s education, speculating, different brokerage accounts and even 

hypothetical portfolios to follow the advice of an investment newsletter. 

Simply tracking investments is not enough.  The PPM program also includes powerful tools to help you analyze 

current and potential investments.  Technical analysis features stock charting tools that provide visual analysis of 

price movements.  Available technical indicators include: moving averages, on-balance volume, stochastic 

oscillators, Wilder's RSI, MACD, relative strength (i.e., Ratio Cantor), polynomial trend analysis and correlation 

analysis.  In addition to technical analysis charts, comparative analysis of annualized total return can be generated 

to identify your best and worst performing investments. 

If you have an internet connection, you can download current price quotes with the click of a button to keep all 

your data up to date. 

SYSTEM REQUIREMENTS 

PPM requires Windows 98 or higher, a hard disk with approximately 3.5 megabytes of free space, 64 Megabytes of 

RAM, and a Windows compatible graphics printer.   

PROGRAM SETUP 

Personal Portfolio Manager has several options that must be set prior to running reports and entering data.  These 

options are accessed by choosing “Preferences” in the “File” menu.  The preferences options are used to set an 

access password and to choose:   the printer and set it’s paper orientation; the font used to display and print 

reports and; the number of months a security must be held for capital gains to be considered medium or long 

term.   

SET PASSWORD 

The Password option is used to enable or disable password protection for running Personal Portfolio Manager.   

To enable password protection: 
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1. Click the Set Password button 

2. Enter your password and click OK 

3. Confirm your password by entering it again.   

The same process is used to change your password.  Setting a blank password disables password protection.   

WARNING:  OWL SOFTWARE WILL CHARGE A FEE FOR RECOVERY OF DATA IF YOU LOST OR HAVE FORGETTEN 

YOUR PASSWORD. 

REPORT FONT 

The Report Font menu selection selects the font and font size that will be used for displaying and printing reports.  

As a starting point, we recommend using Arial at 10 pitch or Times New Roman at 12 pitch. 

PRINTER 

When printing reports, PPM sends reports to the default window's printer using the default printer orientation 

(i.e., Portrait or Landscape).  The Printer Setup button may be used to change the default printer, default 

orientation and other printer options supported by your printer. 

LONG AND MEDIUM TERM MONTHS 

When PPM computes capital gains, it differentiates between long term, medium term and short term capital gains.  

In order that PPM does not become obsolete when there is a change in the tax law, the program allows user 

definition of these holding periods.  The default setting is zero months for medium term and 12 months for long 

term. 

Note:  PPM computes the minimum holding period as the number of months specified plus one day. 

Hint:  If your local tax laws do not differentiate between long, and medium term gains then set the “Medium Term 

Months” to zero.  If there is no differentiation between long, medium and short term capital gains, set both the 

long and medium term months to zero.  All gains will then be reported as long term gains. The default settings are 

appropriate for investors in the USA. 

UPGRADING FROM PERSONAL PORTFOLIO MANAGER FOR DOS 

The “Data Conversion” option located on the File – File Maintenance menu is provided for individuals that are 

upgrading to PPM version 7 from PPM version 4 through 6.   

After clicking the Data Conversion button, a file dialog screen will appear. Select the drive and directory where 

your old PPM data files are stored.  The default directory is c:\PPM6.  Once the correct directory has been 

selected, the program proceeds with the file conversion.   

As compared to earlier DOS versions of PPM, PPM 7 provides expanded capabilities for tracking investment 

objectives, cash accounts and bonds.  Because the older versions do not contain all of the data needed to support 
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these expanded features, some manual editing is needed after conversion of PPM files.  The following paragraphs 

describe information that must be edited or entered into PPM 7 after converting files. 

INVESTMENT OBJECTIVES 

Since specification of investment objectives was not available earlier versions, the investment objective is 

undefined for all transferred securities, savings, other assets and liabilities.  To assign investment objectives to 

assets transferred from OPPM, select the asset type in the define menu then select the asset (i.e., stock, bond, 

etc.).  Select an investment objective by clicking the Select button next to the investment objective field.  

Investment objectives should be defined for all stocks, bonds, savings and other assets transferred to PPM 7.  

BONDS 

PPM 7 requires that the face value of each bond be entered as part of the bond definition.  If you have transferred 

bonds from OPPM, select the Bonds option in the Define menu.  Select a bond in the list and enter the face value 

of the bond on the Bond definition screen.  Repeat this for all bonds transferred to PPM 7. 

Under the old version you may have entered false purchase quantities for bonds to compensate for prices which 

are quoted as a percentage of face value.  For example, if you purchased a $1000.00 bond, you may have entered 

the purchase quantity as 10 so that the net worth report would show the value of the bond as $1000 with a 

quoted price of 100%.  If you did enter false purchase quantities then you will need to correct them manually.  

Purchase quantities may be edited by selecting Transactions –> Bond –> Edit/Delete Transaction.   

SAVINGS, OTHER ASSETS AND LIABILITIES 

Whereas older versions maintained a single record containing only the present value of savings, other assets and 

liabilities, PPM 7 maintains a complete transaction history for these items. When savings, other assets and 

liabilities are transferred to PPM 7, a single record each account is created.  The record contains the present value 

from the old version and carries the date the data was transferred.  You may leave these records alone and simply 

enter deposits and withdrawals beginning after the last transaction entered into the old version.   

Optionally, you may choose to enter old transactions (i.e., deposits , withdrawals, etc.) back to some date such as 

the beginning of the year.  If you do enter old transactions, you will need to edit the record created during the 

transfer.  When editing the record, be sure to change the date to one before the transactions to be entered and 

the amount to reflect the balance as of the first of the old transactions to be entered. 

OPTIONS 

Support for option trading is not provided in PPM 7.  Full support for option trading is provided in Master Investor 

by OWL Software. 

TECHNICAL SUPPORT 

If you are unable to resolve a question or you have difficulty running PPM, please call us or send us a letter or 

email describing the problem.  Include the program version number, the exact text of the error message (if any) 
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and a complete description of the problem, the option you were running when the error occurred and any 

supplemental data that you entered under the option.  If possible, please also include a disk created using the 

Backup Data Files button (your data will be held in strict confidence).  We will investigate the problem and respond 

as quickly as possible. 

Answers to frequently asked questions are available on our web site at: http://www.owlsoftware.com 

Our technical support group can be reached at: 

‘Otto-Williams Ltd. 

P.O. Box 513 

Crownsville, MD  21032 

Phone:  410-849-3590 

EMail:  owl@owlsoftware.com 

http://www.owlsoftware.com 
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LEARNING PERSONAL PORTFOLIO MANAGER 

PPM is distributed with sample data so that you can become familiar with the various options and capabilities of 

the program before entering your own data.  

The following paragraphs provide instructions for using some of the key elements of PPM.  We encourage you to 

experiment with all of the reports, charts and data entry screens to become thoroughly familiar with PPM before 

entering your own data.   

PROGRAM ORGANIZATION 

Personal Portfolio Manager is operated through the use of standard windows menus.  The main menu contains the 

following options: 

File Provides options for setting user preferences and for maintaining data files. 

Define Provides options for entering and editing: portfolio names; investment objectives; cash 

accounts; security names, ticker symbols, target and stop loss prices. 

Transactions Provides options for entering and editing: purchases and sales of  stocks, bonds and 

mutual funds; deposits and withdrawals to cash accounts; and changes in the value of 

other assets and liabilities. 

Income Provides options for entering investment income including interest, dividends and 

capital gain distributions reported by a mutual fund. 

Prices Provides options for updating current and historic prices by downloading them from the 

internet, importing from a file or entering them manually. 

Reports Provides access to over 20 reports. 

Charts Provides access to analytical charts 

Help Provides access to the on-line user’s guide. 

MANAGING PORTFOLIOS 

A central feature of PPM’s capabilities is the ability to create reports for any one portfolio or for any combination 

of portfolios. 

From the main menu choose Reports -> Status Reports -> Net Worth then select all portfolios by clicking the All 

button. Click Run to display the report.  Note how the report separates the assets and liabilities for each portfolio.  

Again, choose Reports -> Status Reports -> Net Worth then select all portfolios by clicking the All button. This 

time, check the Composite Portfolios box before clicking the Run button.  Note how the report composites the 

portfolios together as if they were a single portfolio.   

In organizing your finances, you should consider dividing your assets into enough portfolios to show the finest level 

of detail that you require when reporting on a single portfolio.  At the minimum, we recommend that a portfolio 

be created for each category of tax treatment (taxable, tax deferred, tax exempt, etc.) that applies to your assets.  

In addition, you may want to consider adding hypothetical portfolios to test various trading systems or to monitor 

the performance of advisory newsletters.  To add, rename or delete portfolios from your system, choose Define -> 

Portfolios. 
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PPM gives you the ability to move assets from one portfolio to another.  For example, to move a share lot from 

one portfolio to another choose Transactions -> Stocks -> Edit/Delete Transaction.  Select a stock then select a 

share lot.  When the security transaction screen is displayed, click the Portfolio button.  From the displayed menu 

you may then select an alternate portfolio.  Optionally, you may click the New button to create a new portfolio 

where the share lot will reside. 

To move a savings account from one portfolio to another, choose Define -> Cash/Savings Accounts then select the 

type of account to be moved.  After selecting the account, click the Portfolio button to change the portfolio.  The 

process for moving other assets and liabilities from one portfolio to another is the same as for cash accounts. 

Note:  stocks, bonds and options are defined independently of any portfolio since a given security may reside in 

many different portfolios.  Conversely, savings/cash accounts, other assets and liabilities are defined within a 

portfolio since they can reside in only one portfolio at a time. 

TRACKING CASH ACCOUNTS, OTHER ASSETS AND LIABILITIES 

Within PPM, Cash Accounts can be thought of as any cash based account including bank savings accounts, checking 

accounts, money market mutual funds, certificates of deposit and brokerage cash management or sweep 

accounts.  PPM maintains a complete transaction history of all deposits and withdrawals.   

Cash transactions are entered by choosing Transactions -> Cash Accounts from the main menu.  Choose the cash 

account from the listing of defined cash accounts.  When the listing of existing transactions for the selected 

account appears, choose a transaction to edit or click the New button to enter a new deposit or withdrawal.  

When the Savings screen is displayed, enter the transaction date, amount (plus or minus) and any “Memo” text 

you may need to describe the transaction.  Click the Save button to save the transaction. 

The present balance of savings accounts may be viewed by selecting choosing Reports -> Status Reports -> 

Holdings-by-Type -> Cash Accounts.  A ledger of deposits and withdrawals can be viewed by choosing Reports -> 

Transactions for Selected -> Cash Accounts.  Similar reports are available for other assets and liabilities. 

Other assets are generally property based and may include real estate, cars, rare coins, stamp collections and any 

other property that has a market value.  The value of such assets may be tracked in the same way that cash 

accounts are tracked. 

Liabilities are any cash amount or property that you owe to someone else.  They include the mortgage on your 

house, car loans, installment debt, etc.   

TRACKING SECURITY TRANSACTIONS 

The PPM program provides complete tracking of security transactions with automatic computation of capital gains, 

unrealized gains and return on investment.  Security transactions are entered using options on Transactions menu.   

To record a purchase of a stock or mutual fund choose the Transactions->Stock/Mutual Fund->Buy from the main 

menu.  Choose the Stock or Mutual Fund you want to buy followed by the portfolio where you want the share lot 

to reside.  When selecting the stock and portfolio, you have the option of defining a new stock/mutual fund or 

portfolio if needed.  Once you have chosen the stock and portfolio, you can enter the trade date, number of shares 

and cost information then save the record. 
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Each time a new security transaction is entered and saved, PPM offers an option to withdraw funds from a cash 

account to pay for the purchase or deposit funds to a cash account when shares are sold.  Clicking the Yes button 

on the Sweep Funds dialog allows you to select a savings account for the deposit or withdrawal.   

PPM allows you to designate the cost basis accounting method to be used when selling shares of a stock or mutual 

fund that you own. When computing capital gains, PPM uses the cost basis (including commissions) and the net 

sale amount (after commissions) to determine the gain.  PPM also separates gains into long, mid and short term 

based on the Holding Periods in your preferences.  View a capital gains report by choosing Reports->Income 

Reports->Realized Capital Gains->All.  More detailed information, including commission amounts, is available in 

the transaction reports.   

TRACKING PRICES 

Options on the Prices menu are used to maintain current and historic price and volume data for stocks, mutual 

funds, market indexes, and bonds.  Price and volume data may be entered manually, imported from data files or 

downloaded from the internet.  PPM is capable of maintaining daily price histories on each security.  This price 

history forms the basis for computations of net worth, return on investment, portfolio valuations, unrealized gains, 

etc.  In fact, the current and historic prices are used in nearly all of the reports produced by PPM. 

To manually enter or edit price and volume data for a stock or mutual fund, choose Prices -> Edit Prices -> 

Stock/Mutual Fund.  On the Quotes window click the Stock button and select one of the listed issues.  Enter the 

date of the price quote, the volume, open, high, low and closing prices.  If you enter a date for which a price quote 

already exists, the existing quote will be displayed.  You may also click the Browse/Edit button to view a list of 

existing quotes for the selected stock or fund.   

When you have finished entering or editing a price quote, click the Save button to save the quote to disk.  You may 

then select other securities or click the Done button to return to the main menu. 

TRACKING INVESTMENT INCOME 

The Income menu provides options for entering and editing income derived from your investments.  Income can 

be in the form of interest, dividends, long, mid and short term capital gains distributions from a mutual fund or 

other income.  Note that PPM automatically tracks capital gains from the purchase and sale of securities.  Manual 

entry of capital gains is required only for capital gains distributions from a mutual fund. 

To add interest income from a savings account choose Income -> Cash/Savings Accounts. After selecting one of 

the listed accounts a listing of previously entered income transactions for the selected account will appear.  Click 

the New button to add a new income item and fill in the Income form.  The income type can be changed by clicking 

the down arrow in the Income Type box.  Click the Save button to save the transaction. 

Each time a new income record is added you will have the option to reinvest the income.  If the income was 

derived from a cash or other asset account the program will display a dialog box asking if you want to deposit the 

income into the account from which it was derived.  If the income was derived from a security, you will have the 

opportunity to purchase additional shares of the issue using the income or sweep the income into a cash account. 

Options under Income Reports option in the Reports menu summaries of interest, dividend and other income 

entered using the options in the Income menu. 
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TECHNICAL ANALYSIS 

There are two basic types of stock market analysis.  These are fundamental analysis and technical analysis.  

Fundamental analysis uses corporate earnings, assets, liabilities, cash flow, etc. as a basis for projecting future 

performance of a security.  Technical analysis uses price movements as its primary basis for performance 

predictions. Technical analysis is based on the belief that the fundamental analysis of individual securities is 

already built into its price movements and can, therefore, be virtually ignored. 

STOCK CHARTS 

PPM's three basic stock charting options are accessed by choosing Charts from the main menu. The three basic 

stock charts are described in the following paragraphs.  A variety of technical indicators may be overlaid on each of 

the three basic charts.  These are accessed by clicking on command buttons at the bottom of the chart display. 

The Single Issue option plots price and volume movements of a selected security or market index.  Try this chart by 

choosing Stock Charts -> Single Issue. Once a chart has been displayed, you may click the New button at the 

bottom left of the chart to select another security to be displayed.  Other buttons display technical indicators that 

are described below. 

The Relative Performance option plots a comparative analysis of the price movements of one security against 

another security or a market index.  Prices of the two selected securities are plotted using the same relative scale.  

The price bars and axis labels are color coded to the security names.  Try this chart by choosing Stock Charts -> 

Relative Performance.  Be sure to select 2 different stocks from the subsequent menus.  

The Correlation chart performs a least squares linear regression analysis on the price movements of one security 

versus another security or index.  Correlation is the statistical means of determining whether the prices of one 

security move in direct relation to the prices of a market index or another security.  After entering the year ending 

date, select the two securities to be used in the correlation analysis.   

Correlation analysis operates by plotting a scatter-gram of the closing prices of the first security (measured on the 

y-axis) against the corresponding closing prices of the other security or index (measured on the x-axis).  Once the 

points have been plotted, the straight line that best fits the points is computed and plotted.  The line is computed 

using a least squares linear regression.  The program displays the formula for the plotted line, the standard 

deviation (the standard error between plotted prices and the line), and the correlation coefficient. 

Correlation coefficients range from zero to plus or minus one and provide an indication of how good the price 

relationship is between the two securities.  Values near plus or minus one indicate that there is a strong 

relationship between the price movements of the two securities.  Values closer to zero (-0.75 to +0.75) indicate 

poor correlation.  If the coefficient is negative, it means that a negative price relationship exists (a price increase in 

one yields a corresponding price decrease in the other). 

After plotting the scatter-gram, a price chart of the first selected security is plotted.  The solid green band denotes 

the predicted prices for the security within plus or minus one standard deviation. 

The Correlation chart is most useful when there is a high degree of interdependence between two securities (i.e., 

correlation coefficient is greater than 0.9 or less than -0.9).  Under these circumstances, a sudden deviation of the 

price outside the solid area may indicate a change of market sentiment towards the stock.  Such changes in 
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sentiment are often the result of an unexpected change in earnings, a buy or sell recommendation from a major 

broker, takeover rumors, etc.  Rather than a signal to buy or sell, it is a signal to research any recent news on the 

company. 

TECHNICAL INDICATORS 

Technical indicators may be overlaid on any of the three basic stock charts by clicking the button that corresponds 

to the indicator to be plotted.  These indicators and their interpretation are described in the following paragraphs. 

The MA button plots a simple moving average.  Click the MA button and enter a moving average period in the 

displayed dialog then click OK.  The period entered is the number of data points over which the average is 

computed.  Simple moving averages are commonly interpreted to give a Buy signal when the price is above the 

moving average line and a Sell signal when the price is below the moving average line.  While this method is useful 

in a trending market, it yields poor results (frequent buy and sell signals) in a horizontal market. 

The Exp MA button plots an exponential moving average.  Click the Exp MA button and enter a moving average 

factor in the displayed dialog then click OK.  The moving average factor is the weight applied to each new point 

when it is added to the previous value.  That is, a factor of 10 means that each new point is given a weight of one 

tenth of the previous average when computing the new average.  The formula for this is: 

 EI = EI-1 + (PriceI-EI-1)/Factor 

Exponential moving average lines are interpreted in the same manor as simple moving average lines. 

The Fit button uses a best fit algorithm to fit a polynomial curve to the closing prices. Click the Fit button and enter 

a polynomial order from 1 to 9 then click the OK button.  The polynomial order refers to the number of elements 

in the polynomial equation used to determine the best fit line.  A polynomial order of 1 is a straight line.  Curvature 

and complexity of the line increases as the polynomial order is increased.  The formulation of a fourth order 

polynomial is: 

 Y = A + BX + CX
2
 + DX

3
 + EX

4
 

The best fit line can generally be regarded as a price trend.  A buy is thought to be signaled when the line is moving 

up and prices are below the line.  Conversely, a sell is signaled when the line is trending downward and prices are 

above the line. 

The OBV button plots On-Balance Volume.  On-Balance Volume is a technical indicator that shows the strength of 

price movements by incorporating volume information.  When the stock closes higher than the previous period's 

close, the volume is added.  Conversely, when the stock closes lower, the volume is subtracted.  The cumulative 

value is plotted as a single line that is overlaid on the price chart.  Click the OBV button to display the On-Balance 

Volume line 

The main advantage of this indicator is in determining the level of market support for a price advance or decline.  

For example:  if the price of an issue is increasing over a period and the on-balance volume is relatively flat over 

the same period, it indicates that the price advance has poor support and may not be sustained. 

The MACD button plots the indicator known as Moving Average Convergence Divergence.  MACD is computed as 

the rate at which two exponential moving average lines move relative to one another.  Click the MACD button and 
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enter exponential moving average weights for the fast and slow line.  Hint:  The fast weight must be less than the 

slow weight.   

MACD is plotted on the bottom chart having a simple plus, zero, minus scale shown on the right of the chart  To 

help you understand MACD, you may also want to plot the Exponential Moving Average lines that correspond to 

the weights of your fast and slow MACD lines.  Comparing the MACD plot to the corresponding Exponential 

Moving Averages, you will see that MACD is positive when the slope of the fast moving average is greater than the 

slope of the slow moving average.  MACD is zero when the two moving average lines are exactly parallel. 

MACD is interpreted as giving a buy signal when it crosses the zero line moving from negative to positive.  A sell 

signal is given when the MACD falls from positive to negative. 

The RSI button plots Wilder’s Relative Strength Index.  Click the RSI button and enter the RSI period.  The RSI 

period is the number of points (i.e., days or weeks) over which each RSI value is computed.  The formulation is: 

 RSI = 100 - 100/(1+U/D) 

Where U is the average of the days closing higher during the period and D is the average of the days closing lower 

over the period.  A 14 day interval is the default period on 6 month charts.   

RSI is generally interpreted as showing an overbought condition (sell signal) when the value is above the 70% line.  

An oversold condition (buy signal) exists when the value is below the 30% level.   

The %KD button plots the Stochastic Oscillator (%K) and the Smoothed Stochastic Oscillator (%D).  The stochastic 

oscillator is formulated as: 

 %K = 100 * (Closing Price - Lowest Low)/(Highest High - Lowest Low) 

where the highest high and lowest low are determined over the period you enter.  The smoothed stochastic 

oscillator (%D) is the exponential moving average of %K.  The factor used in the moving average is the number of 

%K periods. 

Click the %KD button to plot the stochastic oscillator.  The stochastic oscillator (%K) is plotted in cyan and the 

smoothed oscillator is plotted in blue.  The generally accepted interpretation of %KD states that an overbought 

condition exists when the %K crosses %D and both are above 70% and pointing downward.  Conversely, an 

oversold condition exists (buy signal) when %K crosses %D and both are trending up but below 30%. 

A simpler interpretation of %KD, and one that we prefer, is to buy when %K is higher then %D and sell when %K is 

lower than %D. 

The Clear button clears any previously plotted oscillators or volume data from the lower chart and displays a clean 

grid for plotting MACD, RSI and %KD.  The Vol button re-plots the volume bar chart. 

ENTERING YOUR OWN DATA 

Once you have become familiar with the various elements of the PPM program and the way they are linked to your 

data, you will want to begin using PPM operationally with your own data.  The following is a step by step 

procedure for setting up PPM with your own data. 
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Delete the sample data.  To delete the sample data and prepare the databases to accept your own personal data 

choose File -> File Maintenance -> Erase All Data.   

Define Portfolios.  To create a new portfolio, choose Define -> Portfolios from the main menu.  In organizing your 

finances, you should consider dividing your assets into enough portfolios to show the finest level of detail that you 

require when reporting on a single portfolio. At the minimum, we recommend that a portfolio be created for each 

category of tax treatment (taxable, tax deferred, tax exempt, etc.) that applies to your assets. 

Define Investment Objectives.  To define a new investment objective choose Define -> Investment Objectives from 

the main menu.  PPM uses investment objectives to classify the allocation of assets in asset allocation reports and 

charts.  Your definition of investment objectives should reflect the type of asset allocation output you desire.   

Define cash accounts and enter transactions.  To define a new cash account choose Define -> Savings/Cash 

Accounts.  Once you have defined a cash account you may enter cash transactions using Cash Accounts option on 

the Transactions menu.  Enter an opening balance as an initial deposit.  We suggest that for old accounts, you use 

the balance at the beginning of a year as your opening balance and enter only deposits and withdrawals that are 

subsequent to that date. 

Define securities and enter trades.  To define a new security choose the security type from the define menu.  Start 

with securities that you currently own then follow up with indexes and securities that you want to track for 

comparative analysis and possible later purchase.  After a security has been defined you may record purchases and 

sales of that security using options in the Transactions menu.  NOTE: When entering old security transactions, it is 

important to enter them in chronological order. 

Enter investment income.  To enter investment income use the income menu and choose the type of asset from 

which the income was derived.  We suggest that you limit your data entry to the current tax year. 

Enter or import current and historic price quotes.  Security price quotes may be entered or imported using the 

options on the Quotes & Splits page.  If you do not have a source of historic price data, you may wish to limit your 

price entries to the current prices and build from there.  If you choose this course, be aware that the Net Worth 

chart and Portfolio Change report will be accurate only from this date forward.  To gain some additional accuracy 

you might consider entering historic price quotes monthly going back to when each security was originally 

purchased. 

After completing this initial setup, maintaining accurate records of your finances is a matter of entering new 

transactions when they occur and downloading, importing or entering current price quotes for securities.   

INVESTMENT DECISIONS 

Remember that investing in stocks and bonds is a form of gambling.  The best any program, trading system or 

analytical technique can hope to achieve is to provide information that will improve your odds of success.  PPM 

will not make investment decisions for you nor will it make recommendations.  It is up to you, the user, to 

interpret the information presented by PPM using your knowledge, experience and intuition.  To make your use of 

PPM more enjoyable, and perhaps more profitable, we suggest that you read some of the many books that are 

available on portfolio management, stock chart interpretation and market timing. 
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THE FILE MENU 

The File menu offers options for customization of PPM, and file maintenance including data backup and restore.  In 

addition, special file maintenance options are provided to help with maintaining some of the large data files used 

by the system. 

Options in the Preferences submenu are described under Program Setup. 

FILE MAINTENANCE 

BACKUP DATA FILES 

The Backup option creates a backup copy of your data files.  Select the drive and directory where you want to store 

the backup files.   

Note:  If you are backing up to a floppy disk, be sure to insert a formatted diskette before selecting that drive.  Be 

aware PPM cannot split individual files across floppy disks. If an individual file (usually prices.dbf) is larger than will 

fit on a single floppy disk, you must backup to a directory on your hard disk. 

RESTORE DATA FILES 

The Restore option copies backup data files created with the File Backup option, to your hard disk and recreates 

the necessary index files.  If your backup data consists of multiple disks, you must insert the disks in the proper 

order. 

Note: When you restore data files, all data present on your system will be overwritten. 

RE-INDEX DATA FILES 

The Re-Index option recompiles the database index files.  Use this option after any abnormal exits from the 

program or if you find that data is missing from your files. 

COMPOSITE DAILY PRICES 

If you find that you do not look at daily (6 month) stock charts that cover periods earlier than a specific date, you 

can dramatically reduce the amount of disk storage required to maintain your data.  The Composite Old Prices 

option replaces daily stock price records prior to a specified date with weekly composite price records.  A weekly 

composite record is composed of the week’s open, close, highest high and lowest low prices, and the week’s total 

volume.  This can dramatically improve the performance of weekly stock charts because the program no longer 

needs to form the weekly composite prices. 
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DELETE OLD PRICES 

As you continue to accumulate data, you may find that you no longer have a need to look at charts containing 

historical prices that are older than a certain date.  The Erase Old Prices option is provided so that you can quickly 

delete old price quotes from your hard disk.  This will save disk space and improve the performance of your 

system.  See also Composite Old Prices. 

Hint:  If you think that at some point in the future you may want to look at old price charts for a specific issue, use 

the price list report and export the prices to a tab delimited file.  You will then be able to import the data at a later 

date if the need arises. 

DELETE OLD NET WORTH VALUES 

PPM maintains a database containing the weekly net worth for all portfolios.  This database is used for Net Worth 

charts and the Portfolio Change report.  If your requirements are such that you do not need to look at net worth 

values prior to a specific date, you can save the disk space that is taken up by those records.   

Hint:  Net Worth data records are automatically created each time you run a report or chart that requires a data 

point that is missing from the net worth database. 

CONVERT OPPM 6 DATA 

This option is provided for individuals that are upgrading to PPM 7 from an earlier version of PPM.  The option 

reads data from Versions 5 and 6 and performs the data conversions needed to build the new version 7 databases. 

Operation of this option is discussed under Upgrading from Personal Portfolio Manager for Dos in the Getting 

Started section. 

ERASE ALL DATA 

PPM is distributed with sample data that is provided to help new users become aquatinted with the capabilities of 

the system without having to enter their own data.  Once you are ready to begin entering your own personal 

financial records, the Erase All Data option provides a quick means of removing all of the sample data from the 

system. 



19 

 

DEFINE 

The Define menu offers options to create, edit and delete master definitions of securities, savings accounts, other 

assets, liabilities, portfolios, and investment objectives.  

Selecting one of these options loads a pop-up menu containing the names of all of the items defined for the 

selected option.  To edit or delete a previously defined item, select it from the menu.  To add a new definition, 

click the New button at the bottom of the menu. 

When you delete an item under the Define menu, the program automatically deletes all records that cross 

reference that master definition.  For example, if you delete a stock’s master definition the program also deletes 

all of that stocks transactions along with any price/volume data that has been entered for that stock. 

DEFINE - PORTFOLIOS 

As the term is used within Personal Portfolio Manager, a portfolio is a logical grouping of financial assets and 

liabilities.  Portfolios are defined as follows: 

Data Field Description 

Portfolio Name A descriptive name that identifies the portfolio.   

When a portfolio definition is deleted, all transactions and income records assigned to that portfolio will either be 

deleted or optionally may be transferred to another portfolio.  

DEFINE - INVESTMENT OBJECTIVES 

As the term is used within Personal Portfolio Manager, an investment objective is a user defined class of assets.  

This may be defined in terms of investment objectives (i.e., growth, tax free income, capital appreciation, etc.) or 

any other classification scheme that is appropriate for the individual user.  Investment objectives are defined as 

follows: 

Data Field Description 

Investment Objective A descriptive name the asset class. 

When an investment objective is deleted, PPM requires that you select another objective to replace the deleted 

objective.  All assets having the deleted objective are reassigned to the replacement objective. 

DEFINE - STOCK, MUTUAL FUND OR INDEX 

Stocks, mutual funds and indexes are defined as shown below. 

Data Field Description 

Stock Name The name of the stock, mutual fund or index 

Symbol The ticker symbol, Sedol or Cusac number used to 

identify the issue in files containing current or 
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historical price quotes that will be downloaded or 

imported using the Prices/Import option. 

Dividend/Yr. The amount of the annual dividend for this stock or 

mutual fund.  This amount is usually listed in the 

financial pages of your newspaper.  Note:  Enter a 

monetary amount -- not a percentage. 

Investment Objective The user defined asset class of the issue.  See 

Investment Objectives above. 

Target Price The price you are hoping the issue to rise to before 

selling. 

Stop Loss Price The price at which you will sell the issue to 

minimize losses should the price fall. 

If you delete a stock, mutual fund or index definition, all transactions, income (interest, dividends, and capital 

gains) and price history data for that issue will also be deleted from PPM’s data files. 

DEFINE - BOND 

Bonds defined as shown below: 

Data Field Description 

Bond Name The name of the Bond 

Symbol The ticker symbol, Sedol or Cusac number used to identify 

the issue in files containing current or historical price 

quotes that will be imported using the Prices/Import 

option. 

Coupon Yield % The stated coupon yield of the bond.  Equivalent to the 

interest rate if the bond were purchased at face value 

Face Value The face value of the bond. 

Maturity Date The date the bond matures. 

Investment Objective The user defined asset class of the bond.  See Investment 

Objectives above. 

Target Price The price you are hoping the issue to rise to before selling. 

Stop Loss Price The price at which you will sell the issue to minimize losses 

should the price fall. 
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If you delete a bond definition, all transactions, income (interest, dividends, and capital gains) and price history 

data for that bond will also be deleted from PPM’s data files. 

DEFINE - CASH ACCOUNTS 

Savings and other cash basis accounts are defined as follows: 

Data Field Description 

Account Name An identifying name of the cash account. 

Portfolio The portfolio in which the account resides. 

Account Number The identifying number of the account. 

Interest Rate The current interest rate paid on this account. 

Investment Objective The user defined asset class of the cash account. See 

Investment Objectives above. 

If you delete a savings definition, all transactions and income data for that account will also be deleted from PPM’s 

data files. 

DEFINE - OTHER ASSETS 

Other assets are generally property assets such as real estate, fine art, coin collections, etc. that you wish to track 

using PPM.  They are defined as follows: 

Data Field Description 

Asset Name A name or description of the asset 

Portfolio The portfolio in which the asset resides. 

Account Number The identifying number of the account. (optional) 

Growth Rate An estimated rate at which the asset appreciates. 

Investment Objective The user defined asset class of the asset. See Investment 

Objectives above. 

If you delete an asset definition, all transactions and income data for that asset will also be deleted from PPM’s 

data files. 

DEFINE - LIABILITIES 

Liabilities include the mortgage on your house, car loans and other debt.  Liabilities are defined as follows: 

Data Field Description 

Liability Name An identifying name of the liability. 



22 

 

Portfolio The portfolio in which the liability resides. 

Account Number The identifying number of the account. 

Interest Rate The current interest rate paid on this account. 

If you delete a liability definition, all transactions for that liability will also be deleted from PPM’s data files. 
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TRANSACTIONS MENU 

The transactions entered under the transaction menu fall into the two classes of security transactions (i.e. buying 

and selling stocks and bonds) and cash type transactions (i.e., increases or decreases to the value of cash accounts, 

other assets and liabilities).  These are described below. 

SECURITY TRANSACTIONS 

BUYING SECURITIES 

To buy a security, choose the security type from the Transactions menu then choose the Buy option.  Select the 

security from the list of pre-defined securities or click the NEW button to define a new security.  After selecting the 

security or defining the security, choose the portfolio in which the new purchase should reside.  Once you have 

chosen the security and portfolio, the Security Transaction screen will be displayed. 

The security transaction screen contains the following information that is to be filled in at the time of purchase. 

Data Field Description 

Security Name A command button on the top left of the screen is labeled 

with the type of the security to be purchased.  Click on the 

command button change the security being purchased.   

Portfolio Click on the Portfolio command button to change the 

portfolio where the purchase lot will reside. 

Purchase Information 

Data Field Description 

Purchase Date The date you purchased the security or option 

Number of Shares The number of shares of the security being purchased.  For 

bonds this is the number of bonds.  For options, this is the 

number of shares covered by the option. 

Cost The total purchase price of security or option excluding 

commissions and fees. 

Commission The commission paid to a broker or dealer for purchasing 

the shares 

Other Cost Any other costs of purchasing the shares such as margin 

costs. 

Total Cost This is automatically computed as the sum of the principal, 

commission and other cost. 
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Cost Basis Computed - You may override this value. 

In addition to purchase information, the security transaction screen also contains sales information.  Note that this 

information appears only for the purpose of editing sale information after it has been posted using the Sell option. 

 

Sales Information 

Data Field Description 

Date Sold The date you sold the security or option 

Gross Amount The gross (total) amount of the sale.  For stocks, this is the 

selling price times the number of shares. 

Commission The commission paid to a broker or dealer when selling the 

security. 

Other Selling Cost Enter any other taxes, fees or expenses associated with the 

sale of the shares. 

Net Amount Computed - Gross amount less commission.  

Cost Basis Computed - You may override this value. 

Gain/Loss Computed - Net amount less cost basis. 

Hint:  When you receive dividends or capital gains distributions that are reinvested in shares of the same stock or 

mutual fund, use the Income menu to record the income then select “Yes” from the Income Reinvested dialog box 

to record the number of shares purchased with the dividend or capital gains distribution. 

SELLING SECURITIES 

To sell a security than you hold, choose the security type from the transactions menu then choose the Sell option.  

Select the security to be sold then select the portfolio which holds the shares you sold.  The Sell screen will then be 

displayed showing the total number of shares of the selected security that are held in the chosen portfolio 

Hint:  If more than one portfolio is involved in the sale of a security the total sale must be divided into one sale for 

each portfolio.  Alternatively, you may reassign purchase lots into a single portfolio prior to entering the sale. 

The sell screen contains the following information. 

Sell Screen Data 

Data Field Description 

Name Click the command button to select the name of the 

security being sold. 
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Portfolio Click the command button to select the portfolio that 

holds the shares to be sold. 

Shares Held Computed - the sum of shares held for the specified 

security in the specified portfolio.  This is the maximum 

number of shares that may be entered into the shares sold 

field. 

Date Sold The date you sold the security or option. 

Shares Sold The number of shares or bonds sold. 

Gross Amount The gross (total) amount of the sale.  For stocks, this is the 

selling price times the number of shares. 

Commission The commission paid to a broker or dealer when selling the 

security. 

Other Cost The total of taxes, fees and other expenses related to the 

sale of the security. 

Sale Method PPM supports IRS approved cost basis accounting methods 

for First In - First Out, Specific Identification, Single 

Category Cost Averaging and Double Category Cost 

Averaging.  Select the method that applies to the sale 

transaction.  Note - In the USA, cost averaging methods 

apply only to mutual funds and once you sell shares using a 

cost averaging method, all subsequent sales of that fund 

must use the same method. 

Net Amount Computed - Gross amount less commission.  

Cost Basis Computed - You may override this value.  The computed 

amount is based on the selected Sale Method.   

 Gain/Loss Computed - Net amount less cost basis. 

SHORT SALES 

A short sale occurs when someone sells stock that they do not hold or do not want to transfer at the time of the 

sale.  To obtain the stock for the short sale, the seller borrows identical stock from a broker to deliver to the buyer.  

At some later date, the seller must cover the borrowed shares either by delivering shares that he or she already 

owns or by buying the stock on the open market. 

To record a short sale in PPM, choose Transactions -> Stock/Mutual Fund -> Sell Short. PPM will then display the 

Short Sale screen.  The Short Sale screen contains the following information to be filled in at the time of the short 

sale. 
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Short Sale Data 

Data Field Description 

Stock Click the command button to select the name of the stock 

being sold. 

Portfolio Click the command button to select the portfolio where 

the short position is to be held. 

Short Sale Date Enter the date the shares were sold short. 

Shares Sold Enter the number of shares sold short. 

Gross Enter the total amount of the short sale. 

Commission Enter the amount of the sales commission plus any 

additional fees you had to pay to borrow the stock. 

Other Cost Any other cost associated with the short sale transaction. 

Net Computed:  Gross less Commission/Other Cost. 

Once a short position has been opened by entering the information above, it will appear on reports as having a 

negative value (i.e., open short positions represent a liability since you owe the shorted shares to the broker you 

borrowed them from). 

To cover, or close, a short position choose Transactions -> Stock/Mutual Fund -> Cover/Edit Short Position and 

select the short position to be covered.  The Short Sale screen will be displayed containing the information that 

was entered when the short position was opened.  The following data must be entered to cover the short position. 

Cover Short Data 

Data Field Description 

Cover Date The date you delivered shares to your broker to cover the 

borrowed shares. 

Cover with New Purchase Select this command button to if you needed to purchase 

the stock to cover the short position.  After clicking this 

command button fill in the rest of the information on the 

screen. 

Cover with Existing Shares Select this command button if you are covering the short 

position with shares you already own.  After clicking this 

button, select the share lots and enter the number of 

shares from each lot that were delivered to cover the short 

position.  Once you have completed your entries the 

balance of the information will be filled in by the program 

and you can click the Save button 
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Acquisition Date The date the shares were acquired 

Cost Cost of shares sold 

Commission The purchase commission 

Other Cost Any other cost associated with the purchase of the stock 

delivered to the broker. 

Total Cost Computed: Sum of the cost, Commission, and other cost 

Cost Basis Computed: This value may not be overridden on short 

sales. 

Gain Computed: Net less Cost Basis. 

TRACKING CASH ACCOUNTS - OTHER ASSETS AND LIABILITIES 

The three buttons labeled “Cash Accounts”, “Other Assets” and “Liabilities” provide the means for recording 

changes in the value of accounts of the corresponding type. 

Before recording cash account, other asset or liability transactions, the account must be pre-defined using options 

in the Define menu.  Once an account has been defined, transactions may be recorded using the “Deposits and 

Withdrawals” option for Cash Accounts or the “Increases and Decreases” option for Other Assets and Liabilities. 

Hint:  Income accrued to a cash or other asset account should be entered using the options in the Income menu.  

Once the income has been entered, a dialog box will be displayed allowing the income to be deposited directly to 

the cash or asset account.  In addition to income, funds may be automatically deposited to and withdrawn from 

cash accounts when buying and selling securities. 

Hint:  To change a deposit to a withdrawal, place a minus sign in front of the amount. 
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INCOME MENU 

The Income menu provides options for entering and editing income derived from your investments.  Income can 

be in the form of interest, dividends, long, mid and short term capital gains distributions from a mutual fund or 

other income.   

NOTE:  PPM automatically tracks capital gains from the purchase and sale of securities.  Entry of capital gains is 

required only for capital gains distributions from a mutual fund. 

To add, edit or delete income, choose the source of the income (i.e., Stock, Bond, Cash Account, etc.) from the 

income menu followed by the actual stock or account from which the income was derived.  Choose a previously 

entered income record or click the New button to enter a new record. 

On the Income screen select the type of income from the pull-down menu.  Note that the default income type 

depends on the type of security selected (i.e., dividends for stocks, interest for bonds and savings, etc.).  After 

selecting the income type, enter the date the income was received and the amount of income.  Click the Save 

button when you have finished entering the required information. 

Each time a new income record is added you will have the option to reinvest the income.  If the income was 

derived from a savings or other asset account the program will display a dialog box asking if you want to deposit 

the income into the account from which it was derived.  If the income was derived from a security then you will 

have the opportunity to purchase additional shares of the issue using the income or sweep the income into a cash 

account. 

If you edit or delete income that was previously swept into a savings account or used to purchase additional shares 

of a security, you must also edit or delete the corresponding transaction. 
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PRICES MENU 

The Prices Menu offers options to maintain current and historic price and volume data for stocks, mutual funds, 

market indexes, bonds and options.  Price and volume data may be entered manually or downloaded from the 

internet or imported from other data files that are available from a variety of information services.  PPM is capable 

of maintaining daily price histories on each security and adjusting the data for stock splits.  This price history forms 

the basis for computations of net worth, return on investment, portfolio valuations, unrealized gains, etc.  In fact, 

the current and historic prices are used in nearly all of the reports produced by PPM. 

In addition to security price and volume data, PPM also maintains a database containing weekly valuations of net 

worth for each portfolio.  The Build Net Worth History option in the Prices menu provides a means of maintaining 

this database. 

ENTERING PRICE AND VOLUME DATA 

Price and volume data may be entered, edited or deleted by choosing the appropriate security type from the 

Prices menu.  Once the appropriate security type is chosen, the Price Quotes screen will be displayed with the 

following information. 

Manual Price Entry Data 

Data Field Description 

Security Name Click the command button (labeled Stock/Fund, Bond or 

Option as appropriate) to select the security for which 

prices are to be entered, edited or deleted.  After entering 

prices for a given security, you may click this button to 

select another security of the same type (Stock, Bond, 

etc.). 

Quote Date Enter the quote date for which prices are to be entered, 

edited or deleted.  Alternatively, an existing quote for the 

security may be selected by clicking on the Browse button. 

Volume Enter the share volume in hundreds. 

Last, High, Low, Open If you are entering a new quote, the high, low and open 

fields will be automatically filled in with the value of last 

when it is first entered.  This saves time when entering 

quotes for mutual funds that have no daily high, low or 

open price. 

Save Click the Save button to save any changes you have made 

to the price record displayed.   

Delete Click the Delete button to delete a displayed price record.  

The delete button is enabled only when an existing price 
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record is displayed.  Once a record is deleted, you may 

undelete it by clicking the UnDelete button. 

Exit button Click the Exit button to exit price entry mode after all 

entries have been saved.   

DOWNLOADING AND IMPORTING PRICE QUOTES 

Current and historic price and volume data is available from a wide variety of sources.  These include the internet, 

on-line services such as CompuServe and AOL as well as others who provide historic price information on diskette.  

Formats for over 20 popular services are pre-defined in PPM. 

DOWNLOADING QUOTES 

Because the internet is ever changing, we recommend that you check our web site at 

http://www.owlsoftware.com for current information on supported quote servers and any special considerations 

you may need when downloading quotes from the internet.  Information specific to supplied download and import 

specifications is provided in Appendix A. 

If your system does not automatically connect to the internet when you launch your internet browser then you will 

need to manually connect to the internet before downloading quotes.  

NOTE:  AOL Users should connect to AOL using the AOL software before clicking the download button. 

To download quotes: 

• Choose Prices -> Download/Import from the main menu.  Choose one of the Data Formats that begin 

with “Download” (e.g., “DOWNLOAD-Yahoo North American”).  When you have chosen a format that PPM 

can download, the button caption will change from “Import” to “Download.”   

• After selecting a download format, set the “Accept Quotes Beginning From” and “Through” dates then 

Click the button labeled Download.  Note: Quotes containing dates that are not within the entered dates 

will be rejected. 

• If you are not already connected to the internet, your dialer dialog box will be displayed. Select the service 

and enter your user name and password.  Click the Connect button.  The program will dial out and 

retrieve the quotes.  HINT: The program does not disconnect from the internet after downloading quotes.  

• When the program has finished retrieving the quotes it will import the quotes and display a message 

indicating the number of quotes that were successfully imported and the number that were appended 

(i.e., new data records). 

IMPORTING QUOTES 

To import quotes, choose Prices -> Download/Import from the main menu.. Note, there are several items that 

must be set up correctly to successfully import quotes.  The Import Quotes screen will be displayed with the 

following information.   

Import Quotes Screen 

Data Field Description 

Data Format Select a data format that begins with “IMPORT” that 
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applies to the data file to be imported. Note: Import 

format names that end in “.L” and “.C.” have special 

meaning.  See Format Name under Defining Import 

Formats below. 

Accept quotes dated  

From - Through 

Enter the date span of the quotes that you want to import.  

Only those quotes dated between the specified beginning 

and ending dates will be imported.  The default is the 

current date. 

Import File Enter the file name that contains the price data to be 

imported.  Alternatively, click the Browse button to display 

a standard file dialog box where you may select the file to 

be imported.  The default is the last file imported. 

Once the above information has been entered, click the Import button.  During the import process, PPM will 

display the quotes as they are loaded.  When the entire file has been processed, PPM will display a message box 

with the count of records that were actually loaded into the database. 

DEFINING DOWNLOAD & IMPORT FORMATS 

Download and import formats can be added and edited as needed to support changes in data sources and new 

data sources.  To add a new format or edit an existing format click the Download/Import Quotes button on the 

Quotes and Charts page.  To edit an existing format, select that format from the Data Formats drop down menu.  

The Setup menu (located in the top left corner of the Download / Import Quotes screen provides access to the 

format definitions. 

Options in the Setup menu include: 

Add Delimited Format Adds a new delimited format.  Delimited formats are for data files that have their fields 

seperated by a delimiting character such as a comma or a tab. 

Add Tabular Format Adds a new tabular format.  Tabular formats describe data files that have data in fixed 

columns that are seperated by spaces. 

Edit Current Format Edits the format that is selected in the Data Formats field. 

Delete Current Format Deletes the format that is selected in the Data Formats field. 

The following data must be entered on the import format screen. 

Import Format Definition Screen 

Data Field Description 

Format Name Enter a descriptive name for the data format.   

Special Format for London Exchange Quotes:  Format 
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Data Field Description 

names that end in “.L” (period followed by capital L) are 

reserved for importing London Exchange quotes from 

some services that output the quotes in units of British 

pence. Special code has been added to PPM to convert 

these quotes from pence to decimal pounds.  The 

conversion takes place only when both the Format Name 

and Ticker Symbol end in “.L”. 

Special Format for Quotes in Cents/Pence: Format names 

that end in “.C” (period followed by capital C) are reserved 

for importing quotes that are expressed in cents.  Special 

code has been added to PPM to convert these quotes from 

cents to decimal amounts (i.e., the value is divided by 100).   

Date Format The purpose of the Date Format entry is to tell PPM how to 

interpret date character strings so that the program knows 

which characters refer to the month, day and year.  The 

date format entry is actually a template that uses Y’s refer 

to the year, M’s for the month and D’s for the day.  This is 

best explained by example. 

If Dates look like Enter 

10/30/93 MM/DD/YY 

10/30/1993 MM/DD/YYYY 

30/10/93 DD/MM/YY 

30.10.93 DD.MM.YY 

931030 YYMMDD 

10/30 MM/DD 

Starting and Ending Columns 

(Tabular Formats) 

When defining a tabular format you must tell PPM the text 

column in which each data field starts and ends.  If a field 

does not appear in the data file, enter a zero for the 

starting and ending column for that field. 

To determine the starting and ending columns of each 

field, use an ASCII text editor such as Notepad to examine 

the file.  Make a note of the column in which each data 

field starts and ends. 

Field Numbers (Delimited 

Formats) 

When defining a delimited format you must tell PPM 

number of the field in which each data item appears.  If a 



33 

 

Data Field Description 

field does not appear in the data file, enter a zero for the 

field number. 

To determine the field numbers, examine the file using an 

ASCII text editor.  Count from the left starting with one and 

add one to the field number each time a delimiter 

character is encountered. 

Alternate Close This entry is used to define an alternate position for the 

closing price. The alternate close field is used when the 

number of fields in the record is less than the Total Fields 

Per Record definition below 

Some data files change the format of the data depending 

on the type of security that is being downloaded.  Most 

commonly, a data service might use a different format for 

mutual funds than it uses for stocks. 

Volume Divided by:  Depending on the data service you use, the share volume 

may be listed as the exact number of shares, hundreds of 

shares, thousands of shares, etc.  The volume divisor allows 

you to convert the listed share volume to the volume in 

hundreds of shares that PPM expects. 

Reject Invalid Dates Depending on the time-of-day when a file was 

downloaded, some data services substitute the time for 

the date.  Normally PPM would reject such a record as 

having an invalid date.  However, if you enter “N” in this 

field (i.e., do not to reject invalid dates), these records will 

be accepted by PPM and assigned a date equal to the 

Ending Date. 

Total Fields per Record Enter the number of data fields in a record that does not 

use the alternate close.  Hint:  the alternate close is used 

whenever the record contains fewer fields than the total 

entered here.  You can force PPM to use the alternate close 

by entering a number of fields greater than exist in the 

records to be imported. 

ASCII Value of Delimiter Enter the ASCII decimal value of the character used to 

separate fields in the record.  ASCII decimal values are 

listed in the back of most DOS manuals. 

Download Host URL The internet address of the site where the quotes are 

being downloaded.  Hint:  This is the basic http address. 
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Data Field Description 

Download Command Prefix The portion of the html command used to display quotes 

that preceeds the ticker symbol(s) 

Download Command Suffix The portion of the html command used to display quotes 

that follows the ticker symbols. 

Max Quotes The maximum number of quotes that can be retrieved in a 

single batch.  PPM will continue processing batches until all 

quotes have been downloaded.  Note: where multiple 

quotes can be retrieved, PPM assumes that the quotes are 

shown on the html command line seperated by plus “+” 

signs.  If your service uses another character then set the 

max quotes to one. 

Hint:  Some data files that appear to be tabular (text in fixed columns) are actually tab delimited. 

RECORDING STOCK SPLITS 

To record a stock split, click the Stock Split button on the Quotes and Splits page, then select the security type 

(Stock, Option, etc.) then select the security that split.  On the Split Definition screen enter the following 

information. 

Stock Split Data 

Data Field Description 

Split:  XXX   For:  YYY Enter the ratio of the stock split such as 2 for 1 or 3 for 2, 

etc.  Stock dividends are also entered as a ratio.  For 

example, a 10% stock dividend would be entered as 1.1 for 

1.  

Effective Date of Split. Enter the date when the stock split became effective. 

When a stock split is recorded, PPM updates historical stock prices having dates on or before the effective date of 

the split in line with post split prices.  For example, prices occurring on or before the effective date of a 3 for 2 split 

are multiplied by a factor of 2/3. 

If you hold shares of a stock on the effective date of a stock split, PPM also adjusts the number of shares held to 

reflect the stock split.  For example, if you hold 100 shares of a stock when it splits 3 for 2, PPM will increase the 

number of shares by a factor of 3/2 (i.e., the 100 shares becomes 150 shares).  Share lots that have already been 

sold are not affected by recording a stock split. 

Hint:  Before recording a stock split you should be sure that your share positions in that stock are correct and reflect 

your share positions on the effective date of the stock split. 
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Warning:  If a stock split occurs after shares have been sold, the return on value report will be computed using pre-

split shares at post-split prices.  While the starting and ending values will be incorrect, the Return on Value will be 

correct. 

RE-COMPUTING HISTORICAL NET WORTH 

PPM automatically creates a file containing weekly net worth values for each portfolio.  These records are created 

whenever a portfolio change report or Net Worth chart needs a net worth value that does not already exist in the 

file.  If the value already exists in the file, it is not recomputed thus saving time when running the report or chart. 

Occasionally, users will need to enter, edit or delete information that, invalidates the net worth values that were 

previously computed and stored in the file.  These entries include reassignment of assets from one portfolio to 

another, backdated transactions and corrections to price data. 

If any of these conditions occur, the Rebuild Net Worth button may be used to rebuild the weekly net worth 

values so that they reflect the current status of entries in your data files.  

NOTE:  If your portfolio contains securities that had splits that were applied after the security or some portion of it 

was sold then the historic net worth computed for that security will not be accurate since it will be computed using 

split adjusted prices but not split adjusted shares. 
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REPORTS 

The PPM report generator provides for generation of a variety of customized reports.  Where appropriate, each 

report can be customized by the user for specified time spans and/or combinations of portfolios.  All reports may 

be either printed, viewed on-screen, or exported for use in other programs.  When exporting for use in a word 

processor, use the Plain Text option.  When exporting reports for use in a spreadsheet or database application; use 

the Tab Delimited option. 

Hint:  The File -> Preferences sub-menu contains options for selecting your default printer, and the font and font 

size used for reports.  If the report text runs together, select a smaller font or font size for report generation.  We 

recommend the font Times New Roman at a pitch of 10 to 12 points, if available. 

Hint:  If when printed the output seems to print on only partial pages then you have selected a font size that is too 

large and requires the program to scale it down in order for it to fit on the page.  This scaling down of the font 

when printed causes the page breaks to be seemingly too frequent. 

The reports divided into 4 primary categories: 

Status Reports Include Net Worth, Open Positions, Unrealized Gains and other reports that indicate the state of 

your investments 

Income Reports Include reports that detail information related to income that may be needed for tax purposes.  

They include realized capital gains, interest and dividend income and a variety of transaction summary and detail 

reports. 

SecurityTransaction Summary Provides a summary of stock and bond transactions for a given period of time.. 

Transaction Detail Lists all entered information for transactions for a specific security, cash account, other 

asset or liability or account. 

Performance Reports Reports that detail the performance of investments such as return on investment, 

Portfolio Internal Rate of Return, etc. 

Master Definitions A single report detailing the internal definitions of all securities and accounts entered 

into Personal Portfolio Manager. 

STATUS REPORTS 

NET WORTH 

The Net Worth report provides a detailed listing of the present value of all stocks, bonds, savings, other assets and 

liabilities for included portfolios.  Subtotals are provided for each asset category.  In standard mode, subtotals are 

also provided for each included portfolio.  In Composite Report mode, all included portfolios are reported as if they 

were a single portfolio.  Stock and bond values are computed using price data for the date of the report or for the 

nearest preceding date if none is available for the selected date  If you have not entered any price data for a given 

stock or bond, its value will be based on your most recent transaction preceding the date of the report. 
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INVENTORY 

The Inventory report provides a summary of the value of all securities held, the unrealized capital gains and the 

available cash in individual portfolios as of a specified date. 

OPEN POSITIONS 

The Open Positions report provides a quick summary of open positions in stocks, mutual funds and bonds.  For 

each security the report lists the number of shares held, the average cost per share, current share price, total cost 

of shares held, current value and the unrealized gain or loss.   

HOLDINGS BY TYPE 

The Holdings by Type report provides a listing of open positions of a specific type.  The report may be generated 

for Stocks-Mutual Funds, Bonds, Savings, Other Assets or Liabilities.  The report lists the present value of all open 

positions for the type selected. 

UNREALIZED GAINS 

The Unrealized Gains report provides a measure of the gains and losses that would be realized if stocks and bonds 

were sold at present prices.  Gains and losses are marked either short, mid or long term depending on the length 

of time the shares were held and the defined holding periods (see Program Setup).  Long, mid and short term 

subtotals are provided for each included portfolio.  The report can be generated for either all securities in the 

selected portfolios or for a single security. 

ASSET ALLOCATION 

The three Asset Allocation reports list the allocation of assets either by portfolio, by asset type or by investment 

objective.  Allocation for each class (i.e., portfolio, type or objective) is expressed as the total asset value of the 

class and the percentage of total assets in the class relative to the total assets of all classes.  Each of the three 

reports may be run for any combination of portfolios. 

Hint:  A graphical representation of asset allocation is available.  See Charts/Asset Allocation. 

TARGET - STOP STATUS 

The Target - Stop Status report generates a listing of the status of the current price versus your target and stop loss 

prices for each security.  The listed status is “OK” if the current price is between the stop loss and target prices.  

“ABOVE TARGET” indicates the current price is greater than the target price and “BELOW STOP” means the current 

price is less than the stop loss price. 
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INCOME REPORTS 

CAPITAL GAINS 

The Capital Gains report generates a listing of the capital gains and losses realized from sales of securities over a 

given time period.  The report can be generated for either all securities in the selected portfolios or for one 

security in selected portfolios.  You will enter the period of time to be covered by the report. 

Gains and losses are marked either short, mid or long term depending on the length of time the shares were held 

and the predefined holding periods (see Program Setup).  Note that capital gains distributions from mutual funds 

are also included in this report. 

INTEREST 

The Interest report generates a listing of interest income received from selected portfolios over a user specified 

time span.  Interest income is listed in chronological order for each security.  Subtotals are provided for each 

security and for each portfolio. 

DIVIDENDS 

The Dividend report generates a listing of dividend income received from selected portfolios over a user specified 

time span.  The dividends are listed in chronological order for each security.  Subtotals are provided for each 

security and for each included portfolio. 

OTHER INCOME 

The Other Income report generates a listing of the income identified as "other income" when it was entered using 

one of the Income options.  The report can be generated for a user selected time span and any combination of 

portfolios.  Like interest and dividend income, other income is listed in chronological order for each security.  

Subtotals are provided for each stock, bond, savings account or other asset and for each included portfolio. 

SECURITY PURCHASES AND SALES 

The report generates a listing of all purchases followed by all sales of stocks, bonds and options.  The report shows 

the number of shares purchased or sold, the share price and the total cost of purchases (including commissions) or 

the net amount (after commissions) for sales. 

SECURITY TRANSACTION SUMMARY 

The security transaction summary report lists a summary of all the purchases and sales of stocks and bonds during 

the selected reporting period.  Purchases are listed in chronological order followed by sales. 
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TRANSACTION DETAIL 

The Detailed Transactions report provides a detailed listing of transactions for a single security, savings account, 

other asset or liability.  From a series of menus, you will select the security type, the specific security or account, 

and the portfolios to be included in the report.  The report then lists all transactions for the selected item during 

the user specified time span. 

SECURITY TRANSACTIONS 

For security transactions, the report lists the transaction date, number of shares, share or option cost, 

commissions and other costs.  If the security was sold or the option was exercised the report also lists the gross 

amount of the sale, sales commission, cost basis and the gain or loss. 

CASH - OTHER ASSET - LIABILITY TRANSACTIONS 

For savings, other assets and liabilities the Detailed Transaction report produces a ledger showing each credit and 

debit to the account during the specified reporting period along with the balance on each transaction date.   

PERFORMANCE REPORTS 

RETURN ON INVESTMENT 

The Return On Investment (ROI) report lists the actual return including dividends on share lots that were held at 

any time during the reporting period.  If the share lot was sold, the ROI reflects the annualized return during the 

period the shares were held.  If the share lot was not sold, the ROI reflects the return from the purchase date to 

the ending date of the report. 

Note:  ROI will be listed as zero for share lots that were bought and sold on the same day and share lots having 

zero cost.  ROI will also be listed as zero for any share lots with a present value of zero.   

RETURN ON VALUE 

The Return On Value (ROV) report lists the actual return including dividends on share lots that were held during 

the entire reporting period.  The ROV computation differs from the Return On Investment in that ROV includes 

only the income and unrealized capital gains that were derived during the reporting period whereas the ROI report 

includes income and capital gains over the entire holding period. 

Hint:  While the ROI report shows how an investment has performed since it was purchased, the ROV report shows 

how an investment has performed over a specific holding period. 

PORTFOLIO INTERNAL RATE OF RETURN (IRR) 

The Portfolio IRR report computes the internal rate of return (return on investment) for an entire portfolio over a 

given period of time.  The computation is performed by adding all the income (i.e., interest, dividends, other 
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income and both realized and unrealized capital gains) accrued in a portfolio and dividing it by the average net 

asset value of the portfolio during that period.   

Hint:  The accuracy of this report is dependent on complete and accurate data entry.  If you fail to enter income 

items such as mutual fund dividend and capital gains distributions, the report will not reflect true returns. In 

addition, income items must be entered into the portfolio from which they were derived or they will be credited to 

the wrong portfolio. 

THEORETICAL PERFORMANCE 

The Theoretical Performance report computes the annualized yield over the reporting period for all stocks, bonds, 

options, savings and other assets.  The Income Rate column of the report indicates the theoretical income that 

would be derived from the issue based on the defined annual dividend (for stocks and mutual funds), the coupon 

rate (for bonds), the interest rate (for savings) and appreciation rate for other assets.  The Capital Gain column is 

based on changes in the price of securities over the period of the report. 

Note:  The performance is theoretical because the income rate is based on defined income rates and not on actual 

income received. 

PORTFOLIO CHANGE 

The Portfolio Change report lists the net worth, and the monetary and percentage change in net worth of selected 

portfolios between two user specified dates.  PPM converts the user specified dates to week-ending dates and 

either computes or retrieves the net worth for those two dates.   

Note:  Net worth values for the current week are always computed then stored in the Net Worth file.  Historic net 

worth values (for weeks earlier than the current week) are computed only if a net worth value for the specific 

week is not already available in the Net Worth file.  See Re-computing Historical Net Worth for more information. 

PRICE CHANGE 

The Price Change report lists the prices and the monetary and percentage change in prices of all securities 

between two user specified dates. 

PRICE LIST 

The Price List report shows the open, high, low, last and volume for a specified security over a selected time 

period.   

Hint:  Use the Export option to create a file containing prices that can be imported by another program.  The Export 

option can create a tab delimited text file that can be imported by most spreadsheet and database programs.  You 

may want to use a text editor to remove page and column header lines before importing the prices into your 

spreadsheet or other application. 
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MASTER DEFINITIONS 

The Master Definitions report lists all defined securities, assets and liabilities showing their type (security type, 

savings, other asset or liability), account number or security symbol and investment objective.   
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CHARTS 

ASSET ALLOCATION 

Asset allocation charts display the percentage of assets assigned to each category in the form of a either a pie 

chart or a bar chart.  The assets may be categorized by portfolio, by asset type or by investment objective.  The 

three asset allocation charts are graphical representations of the information available in the Asset Allocation 

reports. 

Note:  If you select plotting of a pie chart and have more than 8 slices to be plotted, the program will automatically 

revert to a bar chart.   

NET WORTH 

The Net Worth chart provides a graphical representation of changes in the value of one or more portfolios over 

time.  Charts are plotted in the form of an area graph or a ribbon (line) graph.  When multiple portfolios are 

plotted on a single chart, the area graph will show cumulative results with each portfolio stacked on top of the 

preceding portfolio.  The maximum number of portfolios that may be included in a 3 year Net Worth chart is 8.   

Note:  The first time a Net Worth chart is plotted it may take a considerable amount of time to compute and store 

net worth values for each week to be plotted.  Subsequent plotting of Net Worth charts covering the same period 

will use the stored values and will therefore be displayed much faster. 

Hint:  To see the maximum detail of value changes plot only one portfolio at a time.  Note that negative net worth 

values are not plotted. 

STOCK CHARTS 

Options in the Stock Charts menu provide for display of technical analysis charts.  Each time you select one of the 

three options in the Stock Charts menu, the Chart Span dialog box will be displayed allowing you to enter the 

duration (i.e., 6 months, 1 year, 2 years or 3 years) and the ending date (i.e., date of the last point plotted) of the 

chart.  Charts plotted for duration’s of longer than 6 months use weekly composite data formed from daily quotes.  

A weekly composite quote is formed by extracting opening price, highest high, lowest low and the closing price for 

the week. 

The Options button on the Chart Span dialog box provides access to additional chart display options as shown 

below.  Once set, the option settings remain in effect until changed. 

Chart Options Dialog 

Option Description 

Candlestick Chart This option enables plotting of technical analysis charts in 

the candlestick format instead of the default bar chart 

format.  Candlestick charts are useful in recognizing 

patterns of opening versus closing prices.  When the 
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opening price is less than the closing, the price range 

between the opening and closing price is displayed as an 

open box.  Conversely, when the opening price is greater 

than the closing price the range is displayed as a filled or 

solid box.  Hint:  if you imported or entered data that lacks 

valid opening prices the candlestick chart will not produce 

valid results on 6 month charts. 

Show Price Grid 

Show Date Grid 

When enabled, a horizontal price grid and vertical date 

grid is drawn on the chart.  You may want to disable these 

options if you are planning to print the chart on a non-

color printer. 

Show Target/Stop Loss Prices When enabled, horizontal lines showing the defined target 

price and stop loss price are plotted on the chart.  The lines 

are plotted only when they are within the range of prices 

plotted on the chart.  The Target line is plotted in green 

and the Stop Loss line is plotted in red. 

Use Log Scale for Prices When enabled, the price portion of the chart will be 

plotted using a logarithmic scale instead of the default 

linear scale.  Logarithmic scaling has the advantage of 

showing equal percentage price moves with the same 

vertical change regardless of the actual price.   

After entering the chart span and setting any display options, you will select the security or in the case of the 

Relative Strength and Correlation charts the two securities to be plotted.   

Along the bottom of each stock chart there are a series of command buttons that provide access to technical 

indicators and allow plotting of another security using the same chart span and option settings.  Refer to the 

Technical Indicators section for a discussion of interpretation of technical indicators.  

The function of the command buttons are described below. 

Stock Chart Command Buttons 

Button Description 

New After completion of your analysis, click the New button to 

select another security to be plotted. 

MA Plots a simple moving average based on the user defined 

number of weeks. 

Exp MA Plots an exponential moving average based on the user 

defined point weight. 

Fit Plots a best fit 1st to 9th order polynomial curve. The 
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"order" (1 to 9) of the polynomial is user defined.  A first 

order polynomial is a straight line. Curvature and fit 

precision increase as the order of the polynomial increases.   

OBV Plots On-Balance Volume. 

MACD Plots Moving Average Convergence Divergence based on 

the user defined fast and slow point weights.   

RSI Plots Wilder’s Relative Strength Index using a user defined 

period. 

%KD Plots stochastic oscillator (%K) and the slow stochastic 

oscillator (%D) using a user defined period. 

Clear Clears the bottom chart of volume or plotted oscillator 

data. 

Vol Re-plots the volume in the bottom chart 

SINGLE ISSUE 

The Single Issue chart displays the industry standard Price/Volume chart or, optionally, a candlestick chart for one 

security at a time.   

The Price/Volume chart is the basic chart shown in most newspapers.  It provides a graphic display of the open, 

high, low and closing prices, and trading volume.  The price portion of the chart is scaled to provide the maximum 

vertical distribution of prices.  That is, it is vertically stretched to just cover the range of prices to be displayed. 

RELATIVE PERFORMANCE 

The Relative Performance chart compares the price movements of two different securities.  After entering chart 

duration and any option changes, select the two securities to be charted together.  Prices for the first security you 

chose will be displayed on the left axis and prices of the second security will be displayed on the right axis and are 

color keyed to the plotted prices.  The relative performance is plotted at the bottom of the chart as an area plot.  A 

rising line indicates that the primary stock (the first stock selected) is performing better than its counterpart. 

Relative Performance, also known as relative strength or ratio cantor is most commonly used to compare a stock 

to a known index.  The best index to use for a given stock is an index that is well correlated with the stock to be 

examined.  Therefore, when analyzing a semiconductor stock it would be best to compare it to a “Tech” stock 

index or the NASDAQ index which is heavily weighted in technology stocks. 

The common interpretation of Relative Performance is to buy stocks that are outperforming their market sectors 

and sell stocks when they are underperforming their market sectors.   
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CORRELATION 

Correlation is the statistical means of determining whether the prices of one security move in direct relation to the 

prices of a market index or another security. After entering chart duration and any option changes, select the two 

securities to be used in the correlation analysis.   

Correlation analysis operates by plotting a scatter-gram of the closing prices of the first security (measured on the 

y-axis) against the closing prices of the other security or index (measured on the x-axis).  Once the points have 

been plotted, the straight line that best fits the points is computed and plotted.  The line is computed using a least 

squares linear regression.  The program displays the formula for the plotted line, the standard deviation (the 

standard error between plotted prices and the line), and the correlation coefficient.  The mathematical 

formulation of these items is shown below. 

Least squares linear regression line is defined by:  Y = B +AX     where: 

 A = (N* Sum(Xi*Yi) - Sum(Xi)*Sum(Yi)) / (N*Sum(Xi^2) - Sum(Xi) ^2) 

 B = (Sum(Yi)/N) - A*(Sum(Xi)/N) 

The standard deviation is given as S where: 

 S = Sqrt( (Sum(Yi - (B + A*Xi))^2) / (N - 2) ) 

The correlation coefficient "R" is given by: 

 R = (N* Sum(Xi*Yi) - Sum(Xi)*Sum(Yi)) /Sqrt((Sum(Xi - Mean(X))^2 * (Sum(Yi) - Mean(Y))^2) 

Correlation coefficients range from zero to plus or minus one and provide an indication of how good the price 

relationship is between the two securities.  Values near plus or minus one indicate that there is a strong 

relationship between the price movements of the two securities.  Values closer to zero (-0.75 to +0.75) indicate 

poor correlation.  If the coefficient is negative, it means that a negative price relationship exists (a price increase in 

one yields a corresponding price decrease in the other). 

After plotting the scatter-gram, a price chart of the first selected security is plotted.  The solid fill area plotted on 

the price chart represents the solution to the least squares regression -- plus or minus one standard deviation (e.g., 

if the two securities were perfectly correlated then the solid fill area would be centered on the closing prices of the 

first security). 

The Correlation Chart is most useful when there is a high degree of interdependence between two securities (i.e., 

correlation coefficient is greater than 0.9 or less than -0.9).  Under these circumstances, a sudden deviation of the 

price outside the standard error area may indicate a change of market sentiment towards the stock.  Such changes 

in sentiment are often the result of an unexpected change in earnings, a buy or sell recommendation from a major 

broker, takeover rumors, etc.  It is always a signal to be wary. 
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OWL PRODUCT INFORMATION 

‘Otto-Williams Ltd. (OWL Software) is committed to producing intuitive, easy to use, software solutions that meet 

the challenges of today’s fast paced world.  OWL programs have been rated among the best software available by 

major publications including PC World, Computer Novice and the Financial Times.   

No more deciphering complex programs and plowing through confusing software manuals.  At OWL, we listen to 

our customers and design our programs to be easy to use with:  simple menus, context sensitive help, on-line 

user’s guides, and sample data where needed, to help you get started fast.  Our programs allow you to be fully 

operational within minutes. 

MASTER INVESTOR 

MI is a fully integrated system that combines portfolio management with technical analysis. The purpose of MI is 

to help individual investors and professional money managers organize and analyze the information that is critical 

to making informed investment decisions. 

PERSONAL PORTFOLIO MANAGER  

Personal Portfolio Manager is an easy to use portfolio management and technical analysis system designed 

specifically for individual investors who invest with a long term horizon. 

SIMPLE BUSINESS ACCOUNTING  

Simple Business Accounting (SBA) is an easy-to-use accounting system designed specifically, for use by small and 

home based businesses. This new generation of our top rated accounting system (Basic Bookkeeping) has been 

completely redesigned for Windows 95 and includes an all new interface and powerful new features. 

SIMPLE BUSINESS INVOICING & INVENTORY 

Simple Business Invoicing and Inventory (SBII) is a complete sales management system that includes: invoicing, 

inventory management, automated billing, mailing list management, and sales tracking. Invoices and bills can be 

printed on plain paper or your own letterhead. 

GST / VAT ACCOUNTING  

GST / VAT Accounting (GVA) is an easy-to-use accounting system designed specifically, for use by small and home 

based businesses that need to track collection and payment of Goods and Services Taxes (GST) or Value Added 

Taxes (VAT). This is a specialized version of our top rated Simple Business Accounting software. 

GST / VAT INVOICING  

GST / VAT Invoicing (GVI) is a complete sales management system that includes: invoicing, inventory management, 

automated billing, mailing list management, and sales tracking. This specialized version of our Simple Business 
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Invoicing and Inventory is designed to meet the tracking and reporting requirements of jurisdictions that charge a 

Goods and Services Tax (GST) or Value Added Tax (VAT). 

BASIC BOOKKEEPING  

Basic Bookkeeping (BBK) is a very easy-to-use accounting system that is specifically designed for small and home 

based businesses. This single entry accounting system is very straightforward and avoids financial jargon so you 

don't need to be an accountant to understand and use the program. 

BOOKKEEPING FOR REALTORS  

Bookkeeping for Realtors (BFR) is a specialized version of our popular Basic Bookkeeping program. This very easy-

to-use accounting system is specifically designed for real estate sales professionals who need a fast accurate 

means of keeping track of their income and expenses including auto mileage. 

Please check our web site at http://www.owlsoftware.com for current prices and availability.  
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APPENDIX A - DOWNLOAD AND IMPORT CONSIDERATIONS 

Several items must be setup correctly in order to properly import quotes. They are: 

• Ticker symbols in PPM must precisely match the ticker symbols found in the file to be imported.  Ticker 

symbols are entered on the stock/mutual fund definition screen (Option Define/Stocks - Mutual Funds). 

One common mistake is to accidentally place a leading blank in front of the Ticker symbol. If the ticker 

symbol in PPM has a leading blank it won't match the symbol found in the import file. 

• The format of the file being imported must match the format expected by PPM. On the PPM Import 

screen select the format that matches your import file by clicking the down arrow in the combination box. 

• The dates of quotes in the import file must be included within the range of dates entered on PPM's 

import screen.  PPM rejects quotes that are outside the range of dates defined on the import screen.  

Some import files may contain quote times instead of dates or may not contain dates at all.  If this is the 

case, PPM assumes that the quotes is from the ending date of the range of dates entered on the import 

screen. 

DOWNLOADING QUOTES AUTOMATICALLY 

DOWNLOAD-YAHOO FINANCE 

Personal Portfolio Manager can retrieve current quotes for North American and most other exchanges directly 

from the Yahoo quote server.  Before utilizing this feature, it is useful to visit the web site and check to insure that 

the ticker symbols used are the same as those defined in Personal Portfolio Manager. This is particularly important 

if you are retrieving quotes from non US exchanges or quotes for indexes such as the Dow Jones Industrial 

Average.   

Note: Ticker symbols for quotes for non-US exchanges have a suffix consisting of a period followed by the 

abbreviation for the exchange (e.g., the symbol for Air Canada on the Toronto exchange is “AC.TO”, the symbol for 

Air France Group on the Paris exchange is “417533.PA”).  Go to http://finance.yahoo.com and use the Symbol 

Lookup – World Markets option to check for the correct symbol to use. 

DOWNLOAD-YAHOO LONDON .L 

Personal Portfolio Manager can retrieve current quotes for the London stock exchange directly from the Yahoo 

finance quote server.  Before utilizing this feature, visit the web site and check to insure that the ticker symbols 

used are the same as those you have defined in Personal Portfolio Manager.  The ticker symbols used by this 

service have a period followed by a letter that indicates the exchange appended to the ticker symbol.  For 

example, the British Airways symbol on the London exchange is expressed as “BAY.L”.  You must include this 

notation in the stock ticker symbol defined in Personal Portfolio Manager to successfully download and import 

these quotes.  NOTE:  London exchange quotes delivered by this server are expressed in Pence. The program is 

configured to convert these quotes from pence to decimal Pounds Sterling.  Fund shares must also use the “.L” 

representation and not the GBnnnnnnn notation. 

Hint:  Go to http://uk.finance.yahoo.com and use “Symbol Lookup” to check for the correct symbol. 
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DOWNLOAD-YAHOO AUSTRALIA / NEW ZEALAND 

Personal Portfolio Manager can retrieve current quotes for Australia and New Zealand exchanges directly from the 

Yahoo Australia quote server.  Before utilizing this feature, visit the web site and check to insure that the ticker 

symbols used are the same as those defined in Personal Portfolio Manager.  The ticker symbols used by this service 

have a suffix composed of a period “.” followed by an abbreviation for the listing exchange. For example, the 

“Australian and New Zealand Banking Group symbol on the Australian exchange is expressed as “ANZ.AX”.  You 

must include this notation in the stock ticker symbol defined in Personal Portfolio Manager to successfully 

download and import these quotes. 

Hint:  Go to http://au.finance.yahoo.com and use “Symbol Lookup” to check for the correct symbol. 

DOWNLOADING QUOTES MANUALLY 

COMPUSERVE CIM (COMPUSERVE INFORMATION MANAGER) QUOTES 

Current stock quotes can be obtained from CompuServe when using the CompuServe Information Manager 

(DosCim or WinCIM) by selecting the Quotes option under the Services menu.  The CompuServe software permits 

you to pre-define the ticker symbols for the quotes you want to retrieve.  Once you have defined a group of ticker 

symbols, select "Quotes" followed by "Get All" to display the current quotes for all pre-defined issues.  To 

download these quotes to your hard disk select "SAVE" or "SAVE AS" under the File menu.   

Make a note of the directory in which you save the file as well as the file name.  You will need to enter this 

information to import the saved data.  We recommend that you use the same file name each time you download 

quotes and select the overwrite option to replace the previously downloaded file.   

WARNING:  Data downloaded using the CIM Quotes option often contains an update time and not an update date.  

Records that do not contain an update date are assumed to be dated on the ending date of the import time span. 

DOW JONES NEWS RETRIEVAL SERVICE (DJNRS) 

PPM supports quotes retrieved from Dow Jones News Retrieval's current quotes (//CQ), historical quotes (//HQ) 

and Dow Jones Averages (//DJA) databases.   

//HQ:  The historical quotes database allows you to retrieve up to one year's worth of daily quotes for stocks.  

After selecting the HQ database set your communications program to begin logging to a new file.  Enter the symbol 

of the stock followed by "P1" (e.g., IBM P1).  DJNRS will display 12 days of quotes for the selected stock.  Each time 

you press the return key, the preceding 12 days of quotes will be displayed until a full year's of quotes have been 

displayed.  After you have retrieved all the quotes you are interested in, set your communications program to stop 

logging.  Hint:  you may save historical quotes for multiple stocks to a single log file. 

//CQ:  The current quotes database allows you to retrieve current quotes for stocks and mutual funds.  After 

selecting the CQ database set your communications program to begin logging to a new file.  Enter the symbols of 

the stock or mutual funds you want to retrieve.  You may enter up to 5 symbols at a time separated by a space.  

DJNRS will display current quotes for each selected security.  You may enter more symbols as needed.  After you 

have retrieved all the current quotes you are interested in, set your communications program to stop logging.  
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Warning:  do not save current quotes for multiple dates in the same log file.  Since the DJNRS CQ database does 

not display the date, PPM is unable to distinguish the date that the quote applies to.   

//DJA:  The Dow Jones Averages database allows you to retrieve up to one year's worth of daily quotes for the 

various Dow Jones Averages.  After selecting the DJA database set your communications program to begin logging 

to a new file.  Enter the symbol of the average you want to retrieve quotes for followed by "P1" (e.g., DJI P1).  

DJNRS will display 12 days of quotes for the selected average.  Each time you press the return key, the preceding 

12 days of quotes will be displayed until a full year's of quotes have been displayed.  After you have retrieved all 

the quotes for a selected Dow Jones Average, set your communications program to stop logging.  Warning:  do not 

save different averages to the same log file.  PPM reduces volumes of Dow Jones Averages by a factor of 10.  When 

loaded, DJA volumes are in units of thousands instead of hundreds as shown in the DJA download file. 

AMERICA ONLINE (AOL) 

Current or closing stock and mutual fund quotes can be obtained using the Display Portfolio feature of America 

Online for Windows.  After signing onto America Online, click on the Quotes and Portfolios Icon then Click on 

“Portfolios.” 

If you have not already entered ticker symbols for the issues you wish to track, enter each ticker symbol then click 

on “Add to Portfolio.”  The ticker symbols you add to your portfolio are retained for all future sessions so you only 

need to enter them once. 

To display current prices for issues in your AOL portfolio, click on “Display Portfolio.”  To download the quotes, 

click the Download button in the portfolio window then select the download format (we recommend using the 

Metastock format.  These quotes can be imported using the predefined “AOL Portfolio Metastock” format.  (Note:  

other formats are also predefined but the Metastock format provides more data). 

Historic quotes can also be downloaded from AOL and imported using the predefined “AOL Historic” format.  To 

access historic quotes on AOL, click the Historic Quotes icon on AOL’s Quotes and Portfolios screen. 

PRN-5 FORMAT (FARPOINT BBS) 

The PRN-5 format is an ASCII -- comma delimited format having records of the following form:   

 date,high,low,close,volume  

where the date is in the form "YYMMDD" and prices are in decimal format.  For example, a record for 30 October 

1993 would be written:   

 931030,27.5,26.125,27.25,30643  

All records in a given PRN-5 file are for a single issue (ticker symbol).  The Farpoint BBS provides free (except for 

the cost of the phone call) downloading of historical stock quotes in PRN-5 format.  Data is available for most 

stocks listed on US stock exchanges.  When downloading from this service you will download one file for each 

stock using one of several supported file transfer protocols such as XModem.  The phone number for Farpoint BBS 

is (312) 274- 6128.   
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PRN-7 FORMAT (QUOTE.COM SINGLE ISSUE HISTORICAL DATA). 

The PRN-7 format is an ASCII -- comma delimited format having records of the following form: 

 date,open,high,low,close,volume,open interest 

where the date is in the form "YYMMDD" and prices are in decimal format.  For example, a record for 30 October 

1993 would be written:   

 931030,26.750,27.500,26.125,27.250,30643,0  

Mutual fund data is written as 

 date,NAV (net asset value) 

Quotes in this form are available via Internet FTP from Quote.Com (there is a charge for each file downloaded).  

For information about this service send EMail to:  support@quote.com or visit their web page at 

http://www.quote.com. 

PRN-8 FORMAT (QUOTE.COM EMAIL) 

The PRN-8 format is an ASCII -- comma delimited format having records of the following form: 

 symbol,date,open,high,low,close,volume,open interest 

where the date is in the form "YYMMDD" and prices are in decimal format.  For example, a record for 30 October 

1993 would be written:   

 GE,931030,26.750,27.500,26.125,27.250,30643,0  

Mutual fund data is written as 

 symbol,date,NAV (net asset value) 

Quotes in this form are available via Internet EMail and FTP from Quote.Com.  For information about this service 

send EMail to:  support@quote.com or visit their web page at http://www.quote.com. 

JUST DATA (AUSTRALIAN STOCK EXCHANGE) 

PPM will import daily stock quotes downloaded from "Just Data" data service in Australia (Just Data, 26 Bellevue 

Street, Highgate Hill, Q 4101, Phone 008 777 972 or (07) 899 2148).  Downloaded file data should be in the 

following form:   

ad19900814cnAdtSdbJDvn1.0  Header / date record 

cABCs1f1050h1100l1050a1100v65000 Stock price records  

cCBAs1f990h1020l980a1000v1022  



52 

 

cDBAs1z2200v45000  

yUGa2220.7  Index price records  

The above format is exactly as the data is downloaded from Just Data and should not be modified by any of Just 

Data's available data conversion utilities.  If multiple days of data are contained in a single file, the price records for 

each day must be separated by a Header/Date record. 

MICROSOFT INVESTOR:  HTTP://INVESTOR.MSN.COM/ 

Microsoft Investor offers relatively convenient downloads of current quotes via their “Portfolio” feature and is the 

only site that we are aware of at this time to offer free historic quotes.  Before you can download quotes, you will 

need to download and install Microsoft’s “Investor” software (a free browser plug-in).   

Downloading Current Quotes 

Once you have downloaded and installed the plug-in, you will be able to set-up a tracking portfolio containing the 

ticker symbols of the stocks you want to track.  The system also has the capability of recording the number of 

shares and purchase cost.  For the purposes of downloading current quotes, only the ticker symbol is required.  For 

privacy reasons, we recommend that you do not enter your number of shares and purchase cost information. 

After setting up the portfolio find the File menu on the portfolio screen and choose “Export” > “Prices to Text File” 

or “Portfolio to Tab Delimited File”.  A dialog box will appear asking you to supply the file name and optionally 

choose a directory.  Remember the name you give the file and the directory where the file is saved. You will need 

this information when you later import the quotes into PPM. 

When importing this data to PPM, choose the import format that corresponds to the export option chosen (i.e., 

MS Investor Prices for “Prices to Text File” and MS Investor Port for “Portfolio to Tab Delimited File”). 

Downloading Historic Quotes 

In MS Investor choose the “Stocks” link from the links in the title bar of the Microsoft Investor site.  Under Stock 

Research choose “Historical Charts.” Enter the symbol for a stock or mutual fund.  Once the chart is displayed, click 

the Options button followed by the view tab to choose Daily, Weekly or Monthly qoutes.  Click the Period button 

to choose the number of months or years of data you want to download.  After selecting all your options, choose 

the Export Data button to download the prices. 

Depending on your system and browser configuration, one of the following actions will occur. 

A dialog box will appear giving you the option of saving the file or specifying what application you want to use to 

view the file.  Choose the Save File option. 

The file will be displayed in your browser as plain text.  Click the File menu in your browser and choose Save As.  In 

the file dialog box under file type choose “Plain Text.”  

The file will be displayed using Notepad. Click the File menu in Notepad and choose Save.  You can then close the 

Notepad application. 

The file will be displayed in an Excel spreadsheet.  Click the File menu in Excel and choose Save.  Note, that when 

closing Excel, it may display a dialog box asking if you want to re-save the file in Excel format. Answer NO. 

In each case, make a note of the name of the file you saved and the exact directory where it was saved.  You will 

need to supply this information to PPM when you import the file. 
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When importing this data to PPM, choose the “MS Invest Historical” import format in Personal Portfolio Manager. 

QUOTE.COM:  HTTP://WWW.QUOTE.COM/ 

Both current and historic quotes can be obtained from Quote.Com.  There is a usage fee for this service.  See PRN - 

7 and PRN - 8, above for information on importing two of the available formats. 

MONEYWORLD:  HTTP://WWW.MONEYWORLD.CO.UK 

Moneyworld offers free quotes from the London Exchange.  Downloadable quotes include the FT-100 and FT-250.   
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